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1. Related Manuals 
 
To ensure system safety, make sure to always read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device used in the 
system.  
The table below lists the manuals provided by HMS Industrial Networks (hereinafter referred 
to as "HMS") and OMRON Corporation (hereinafter referred to as "OMRON"), which pertain to 
this guide.  
 

Manufacturer Cat. No.  Model Manual name 
OMRON W500 NJ501-□□□□ 

NJ301-□□□□ 
NJ101-□□□□ 

NJ-series CPU Unit  
Hardware User's Manual 

OMRON W535 NX701-□□□□ NX-series CPU Unit  
Hardware User's Manual 

OMRON W593 NX102-□□□□ NX-series   
NX102 CPU Unit 
Hardware User's Manual 

OMRON W578 NX1P2-□□□□ NX-series  
NX1P2 CPU Unit  
Hardware User's Manual 

OMRON W501 NX701-□□□□ 
NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

NJ/NX-series  
CPU Unit  
Software User's Manual 

OMRON W506 NJ/NX-series  
CPU Unit Built-in EtherNet/IPTM Port  
User's Manual 

OMRON W504 SYSMAC-SE2□□□ Sysmac Studio Version 1 
Operation Manual  

OMRON 0969584-7 W4S1-05□ 
W4S1-03B 

Switching Hub  
W4S1-series  
Users Manual  

HMS HMSI-27-316 AB7072 User Manual 
Anybus® CommunicatorTM 
for EtherNet/IPTM / Modbus-TCP 
(2-port version) 

HMS SP1708 AB7072 Anybus Communicator - EtherNet/IP 
Interface Installation Sheet 
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2. Terms and Definitions 
 

Term Explanation and Definition 
node It refers to a relay point, a junction point or an end point on an 

EtherNet/IP network made up of devices having an EtherNet/IP port.  
A device with one EtherNet/IP port is recognized as one node and two 
EtherNet/IP ports as two nodes on an EtherNet/IP network.  

tag A unit that is used to exchange data with tag data links. Data is 
exchanged between the local network variables and remote network 
variables specified in the tags or between specified I/O memory areas.  

tag set  When a connection is established, one or more tags (up to eight tags 
including Controller status) are configured as a collective set of tags. 
This is called a tag set. Each tag set represents a unit of data for one tag 
data link connection. Tag data links are therefore created through a 
connection between one tag set and another tag set.  
A tag set name must be set for each tag set.  

tag data links The standard EtherNet/IP implicit communications are called tag data 
links. Tag data links enable cyclic tag data exchanges on an EtherNet/IP 
network between Controllers or between Controllers and other devices.  

connection It is used to exchange data as a unit within which data concurrency is 
maintained.  

connection type There are two kinds of connection types for tag data links.  
One is a multi-cast connection, and the other is a unicast (point-to-point) 
connection. The multi-cast connection sends an output tag set in one 
packet to more than one node. The unicast connection separately sends 
one output tag set to each node. Therefore, the multi-cast connection 
can reduce the communications load if one output tag set is sent to more 
than one node.  

originator and target To make tag data links, it is necessary to establish connections between 
nodes that perform tag data links. The node that requests the connection 
is called the originator, and the node that receives the request is called 
the target.  

tag data link 
parameters 

The information that is set to make tag data links (including tags, tag sets 
and connections) is called tag data link parameters.  

EDS file A file that describes information unique to a device such as the number 
of I/O points for an EtherNet/IP device.  

  



3．Precautions 

 3 

3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing a safety 
circuit, in order to ensure safety and minimize the risk of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and follow the information provided 
in all Safety Precautions and Precautions for Safe Use in the manuals for each device 
used in the system. 

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this guide 
without the permission of OMRON Corporation.  

(5) The information contained in this guide is current as of November 2020. It is subject to 
change for improvement without notice.  

 
The following notations are used in this guide.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally, there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or property damage. 

 
 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in the text. 
This example shows a general precaution for something that you must do. 
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4. Overview 
 
This guide describes procedures for connecting an HMS Anybus Communicator for 
EtherNet/IP (hereinafter referred to as the "Communicator") and an OMRON NJ/NX-series 
Machine Automation Controller (hereinafter referred to as the "Controller") via EtherNet/IP 
and for checking their communication status.  
Refer to Section 6. EtherNet/IP Settings and Section 7. EtherNet/IP Connection Procedure to 
understand setting methods and key points to operate EtherNet/IP tag data links.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows.  
 
Manufacturer Name Model 

OMRON NJ/NX-series CPU Unit NX701-□□□□ 
NX102-□□□□ 
NX1P2-□□□□ 
NJ501-□□□□ 
NJ301-□□□□ 
NJ101-□□□□ 

HMS Anybus Communicator-EtherNet/IP Slave 
2-port version 
single port version 

 
AB7072 
AB7007 

 

 Precautions for Correct Use 

In this guide, the devices with models and versions listed in 5.2. Device Configuration are 
used as examples of applicable devices to describe the procedures for connecting the 
devices and checking their connection.  
You cannot use devices with versions lower than those listed in 5.2.  
To use the above devices with models not listed in 5.2 or versions higher than those listed in 
5.2, check the differences in the specifications by referring to the manuals before operating 
the devices.  

 

 Additional Information 
This guide describes the procedures for establishing the network connection.  
It does not provide information on operation, installation, wiring method, device functionality, 
or device operation, which is not related to the connection procedures.  
Refer to the manuals or contact the manufacturers of the applicable devices.  
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5.2. Device Configuration 
The hardware components to replicate the connection procedures in this guide are as follows:  
 
 
 
 
 
 
 
 
 
 

 
Manufacturer Name Model Version 
OMRON NX-series CPU Unit 

(Built-in EtherNet/IP ports) 
NX102-1200 Ver.1.40 

— Power supply (24 VDC for Controller) —  
OMRON Switching hub W4S1-05C Ver.1.0 
OMRON Sysmac Studio SYSMAC-SE2□□□ Ver.1.29 
— Personal computer  

(OS: Windows 10) 
—  

— LAN cable (STP (shielded, 
twisted-pair) cable of Ethernet 
category 5 or higher) 

—  

HMS Anybus Communicator for 
EtherNet/IP 

AB7072 Ver. 3.03 

HMS Configuration cable (RS-232) (supplied with Communicator)  
HMS EDS file 005A000C00540300.EDS.eds Ver.1.3 

HMS Anybus Configuration Manager - 
Communicator RS232/422/485 

— Ver.4.5.1.0 

— Power supply  
(24 VDC for Communicator) 

—  

 

 Precautions for Correct Use 

Contact HMS Industrial Networks to obtain the EDS file specified above before proceeding. 
Please note that you need the EDS file relevant to your device. If you use the other model 
(not the one specified above), contact HMS Industrial Networks and obtain the relevant EDS 
file.  

 

 Precautions for Correct Use 

Update Sysmac Studio to the version 1.29 or to a higher version. If you use a version higher 
than the one specified, the procedures and related screenshots described in Section 7 and 
the subsequent sections may not be applicable. In that case, use the equivalent procedures 
described in this guide by referring to the Sysmac Studio Version 1 Operation Manual (Cat. 
No. W504).  

Power supply 

Communicator 
Personal computer  
(Sysmac Studio and 
Anybus Configuration 
Manager installed, 
OS: Windows 10) 
 

LAN cable 

Configuration cable (RS-232C) 
 

LAN cable 

Power supply 

NX102-1200 
(Built-in EtherNet/IP ports) 

W4S1-05C LAN cable 

Power supply 
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 Additional Information 
For information on the power supply specifications of the Controller, refer to the NX-series 
NX102 CPU Unit Hardware User's Manual (Cat. No. W593).  

 

 Additional Information 
For information on the power supply specifications of the switching hub, refer to the Switching 
Hub W4S1-series Users Manual (Cat. No. 0969584-7).  

 

 Additional Information 
For information on the power supply specifications of the Communicator, refer to the User 
Manual Anybus® CommunicatorTM for EtherNet/IPTM / Modbus-TCP (2-port version) 
(HMSI-27-316). 
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6. EtherNet/IP Settings 
 
This section describes the parameters, global variables, tag sets and connection settings that 
are all defined in this guide.  
 

6.1. Parameters 
The following parameters are required to connect the Communicator and the Controller via 
EtherNet/IP.  
 

Name Setting item Setting value 
Controller PORT1 (EtherNet/IP) 
(node 1) 

IP address 192.168.250.1 
Subnet mask 255.255.255.0 

Communicator (node 2) 

Fieldbus type EtherNet/IP & 
Modbus-TCP 2-Port 

IP address 192.168.250.2 
Subnet mask 255.255.255.0 
Protocol mode Generic Data Mode 
Control/Status word Disabled 
Input data size 32 bytes 
Output data size 32 bytes 

 

 Additional Information 

For information on the setting values for the Communicator, refer to the User Manual 
Anybus® CommunicatorTM for EtherNet/IPTM / Modbus-TCP (2-port version) (HMSI-27-316). 
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6.2. Global Variables 
The global variables are used for the Controller and can be specified as tags for tag data links. 
The following tables show the global variables and related settings.  
 
Output (Controller to Communicator) 

Name Data type Network 
publish 

Communicator  
data assignment  

Data size 
(byte) 

EIP002_data_OUT BYTE[32] Output Gateway data 32 
 

Input (Communicator to Controller) 

Name Data type Network 
publish 

Communicator  
data assignment 

Data size 
(byte) 

EIP002_data_IN BYTE[32] Input Gateway data 32 
 

 Precautions for Correct Use 

The data type of tag data links for the Communicator can also be set to BOOL; however, if 
the data size is an odd-numbered byte, do not use the BOOL type but the BYTE type instead. 

 

 Additional Information 
For information on setting the data in tag data links for the Communicator, refer to the User 
Manual Anybus® CommunicatorTM for EtherNet/IPTM / Modbus-TCP (2-port version) 
(HMSI-27-316). 

 

 Additional Information 
With Sysmac Studio, two methods can be used to specify an array for a data type.  
After specifying, (1) is converted to (2), and the data type is always displayed as (2).  

(1)BOOL[16] / (2) ARRAY[0..15] OF BOOL 
In this guide, the data type is simplified by displaying BOOL[16].  
(The example above means a BOOL data type with sixteen array elements.)  
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6.3. Tag Sets 
The tag sets for tag data links are shown below.  
 
Output (Controller to Communicator) 

Tag set name Data size (byte) 
EIP002_OUT 32 

 OUT No. Tag name  
(global variable name) Data size (byte) 

 1 EIP002_data_OUT 32 
 
Input (Communicator to Controller) 

Tag set name Data size (byte) 
EIP002_IN 32 

 IN No. Tag name  
(global variable name) Data size (byte) 

 1 EIP002_data_IN 32 
 
  



6．EtherNet/IP Settings 

 11 

6.4. Connection Settings 
The connection settings (i.e. tag data link table) are shown below.  
 

Connection name Connection I/O type RPI (ms) Timeout value 
default_001 Exclusive Owner 50.0 RPI x 4 

 

Input / 
Output 

Target Device 
（Communicator） 

Originator Device 
(Controller) Connection 

type Target variable 
(instance number) 

Size 
(byte) 

Originator variable 
(tag set name) 

Size 
(byte) 

Input 100 32 EIP002_IN 32 Point to Point 
connection 

Output 150 32 EIP002_OUT 32 Point to Point 
connection 
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7. EtherNet/IP Connection Procedure 
 
This section describes the procedures for connecting the Communicator and the Controller via 
EtherNet/IP. The procedures for setting up the Communicator and the Controller in this guide 
are based on the factory default settings. Refer to Section 8. Initialization Method for 
information on how to initialize the Controller.  
 

7.1. Work Flow 
Take the following steps to connect the Communicator and the Controller via EtherNet/IP and 
to operate tag data links.  

 
7.2. HMS Communicator Setup  Set up the HMS Communicator. 

↓   
 7.2.1. Hardware Settings  Connect the cables to the Communicator. 

↓   
 7.2.2. Parameter Settings  Set parameters for the Communicator. 

↓   
7.3.  Controller Setup   Set up the Controller.  

↓   
 7.3.1. IP Address Settings  Start Sysmac Studio and set the IP address of the 

Controller.  
↓   

 7.3.2. Installing the EDS File  Install the EDS file. 
↓   

 7.3.3. Registering the Target Device  Register the target device.  
↓   

 7.3.4. Setting Global Variables  Set global variables to use as tags for tag data links.   
↓   

 7.3.5. Registering Tags  Register tags and tag sets.  
↓   

 7.3.6. Setting Connections  Set connections to associate the target variables 
with the originator variables.  

↓   
 7.3.7. Transferring the Project Data 

 
Place Sysmac Studio online and transfer the 
connection settings and project data to the 
Controller.  

↓   
7.4. EtherNet/IP Communication 

Status Check  
 

Confirm that EtherNet/IP tag data links are in normal 
operation.  

↓   
 7.4.1. Checking the Connection 

Status 
 Check the EtherNet/IP connection status.  
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7.2. HMS Communicator Setup 
Set up the HMS Communicator. 
 

7.2.1. Hardware Settings 
Connect the cables to the Communicator. 
 

 Precautions for Correct Use 

Make sure the power supply is OFF before setting up.  
If it is ON, the settings described in the following steps and subsequent procedures may not 
be applicable.  

 

1 Make sure Power supply to 
Communicator is OFF. 

 

2 Check the position of the 
connectors on Communicator by 
referring to the figure on the 
right. 

        

3 Connect a LAN cable to 
Ethernet Port 1(IN). 

 

LAN cable 

Ethernet Port 1 (IN) 

A: Ethernet Port 1(IN) 
B: Ethernet Port 2(OUT) 
C: Status LEDs 
D: PC-Connector 
E: Subnetwork Connector 
F: Power Connector 
G: DIN-rail Connector 
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4 Connect Power supply to Power 
Connector. 
 
*For information on the power 
supply connection to 
Communicator, refer to the 
User Manual Anybus® 

CommunicatorTM for 
EtherNet/IPTM / Modbus-TCP 
(2-port version) (HMSI-27-316) 
or the Anybus Communicator - 
EtherNet/IP Interface 
Installation Sheet (SP1708).  

  

Power supply 
Power Connector 
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7.2.2. Parameter Settings 
Set parameters for the Communicator. 
The Anybus Configuration Manager - Communicator RS232/422/485 (hereinafter called 
"ACM") is used to set parameters.  
Install the software on your computer before proceeding. 
 

 

Additional Information 
For information on how to install ACM, refer to 1.4 Software Installation of the User Manual 
Anybus® CommunicatorTM for EtherNet/IPTM / Modbus-TCP (2-port version) (HMSI-27-316). 

 

 Additional Information 
This procedure provides the minimum necessary settings for EtherNet/IP communications. 
For more information on the parameter settings with ACM, refer to the User Manual Anybus® 

CommunicatorTM for EtherNet/IPTM / Modbus-TCP (2-port version) (HMSI-27-316). 

 
 

1 Connect a Configuration cable 
between Personal computer and 
PC-Connector at the bottom of 
Communicator. 
 
*For information on connecting 
Personal computer and 
Communicator, refer to the 
User Manual Anybus® 

CommunicatorTM for 
EtherNet/IPTM / Modbus-TCP 
(2-port version) (HMSI-27-316) 
or the Anybus Communicator - 
EtherNet/IP Interface 
Installation Sheet (SP1708). 

 

2 Turn ON Communicator.  

3 Start ACM on Personal 
computer.  

 

Configuration cable 

PC-Connector 

Personal computer 
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4 ACM starts up.  
The Select Configuration Dialog 
Box appears. 

 

5 Select Blank Configuration and 
then click OK in the Select 
Configuration Dialog Box. 

 

6 The main window of ACM 
appears. Select Communicator 
RS232/422/485 in the 
Navigation Section (Devices) 
displayed on the left side of the 
main window. 

 

7 The Parameter Section 
(Configuration) related to 
Communicator RS232/422/485 
appears on the right side of the 
main window. 
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8 In the Parameter Section 
(Configuration), select Generic 
Data Mode from the pull-down 
list in the Protocol Mode Field 
under Protocol while selecting 
the Categorized Tab (default 
view).  
 
 
 
 
Check that Protocol Mode is set 
to Generic Data Mode. 

 
 

 

9 Select Fieldbus in the 
Navigation Section (Devices) 
displayed on the left side of the 
main window. 

 

10 The Parameter Section 
(Configuration) related to 
Fieldbus appears on the right 
side of the main window.  
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11 In the same way as step 8, 
select EtherNet/IP & 
Modbus-TCP 2-Port from the 
pull-down list in the Fieldbus 
Type Field under Fieldbus. 
 
 
 
 
The parameters for EtherNet/IP 
& Modbus-TCP 2-Port are 
displayed. 

 

 

 

12 Set the following communication 
parameters. 
 

Communicator IP-address: 
192.168.250.2 

Subnet Mask:  
        255.255.255.0 
IO Sizes:  
        Automatic 

  

13 Click + to the left of Subnetwork 
in the Navigation Section 
(Devices) displayed on the left 
side of the main window, to 
expand the entry. 
The sub-entry "New Node" is 
displayed under Subnetwork. 
Right-click New Node and 
select Add Transaction 
Produce from the menu. 
 
Check that Produce 1 is added 
under New Node. 
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14 Right-click Produce 1 and 
select Add Variable Data from 
the menu. 
 
 
 
 
 
 
 
Check that VariableDataObject 
is added under Produce 1.  

 
 

 

15 The Parameter Section 
(Configuration) related to 
VariableDataObject under 
Produce 1 appears on the right 
side of the main window.  
Set Maximum Data length to 
0x0020 (32 bytes). 

 

16 In the same way as step 13, 
right-click New Node and select 
Add Transaction Consume 
from the menu. 
 
 
 
 
Check that Consume 1 is added 
under New Node. 
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17 In the same way as step 14, 
right-click Consume 1 and 
select Add Variable Data from 
the menu. 
 
 
 
 
 
 
 
Check that VariableDataObject 

is added under Consume 1.  

 
 

 

18 The Parameter Section 
(Configuration) related to 
VariableDataObject under 
Consume 1 appears on the right 
side of the main window.  
Set Maximum Data length to 
0x0020 (32 bytes). 

 

19 Select Communicator 
RS232/422/485 in the 
Navigation Section (Devices) 
displayed on the left side of the 
main window. 
 
VariableDataObject on the 
menu bar changes to 
Communicator RS232/422/485. 

     

20 Select Connect from the 
Communicator RS232/422/485 
Menu.  

21 Check that the Config Line LED 
in the lower right of the main 
window turns green.  
 
*It indicates that ACM is online. 
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22 Select Download 
configuration to 
Communicator RS232/422/485 
from the Tools Menu. 

 

23 The Name the Configuration 
Dialog Box appears.  
Check the message and click 
OK. 
 
 
 
 
 
 
The Download Dialog Box 
appears showing the download 
progress. Check that the dialog 
box is automatically closed 
when the download is 
completed.  

 
 

 

24 In the same way as step 19, 
select Disconnect from the 
Communicator RS232/422/485 
Menu while selecting 
Communicator RS232/422/485 
in the Navigation Section 
(Devices) displayed on the left 
side of the main window. 

 

25 Check that the Config Line LED 
in the lower right of the main 
window turns red.  
 
*It indicates that ACM is offline. 

 

26 Turn OFF Communicator.  

27 Disconnect the Configuration 
cable between Personal 
computer and Communicator.  
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7.3. Controller Setup 
Set up the Controller.  
 

7.3.1. IP Address Settings 
Start Sysmac Studio and set the IP address of the Controller.  
 

1 Make sure Power supplies to 
Switching hub, Controller and 
Communicator are all OFF. 

 

2 Connect Personal computer and 
Switching hub with a LAN cable. 
Connect Switching hub and 
Built-in EtherNet/IP port 
(PORT1) on Controller with a 
LAN cable. 
Connect Switching hub and the 
other end of the LAN cable 
which at one end has been 
connected to Communicator in 
the previous procedure 7.2.1. 
 
Connect Power supplies to 
Controller and Switching hub, 
respectively. 
 
*For information on the power 
supply connection to 
Controller, refer to 5-4-1 Wiring 
the Unit Power Supply of the 
NX-series NX102 CPU Unit 
Hardware User's Manual (Cat. 
No. W593).  

 
 
 
 
 
 
 

3 Start Sysmac Studio.  
 
*If the User Account Control 
Dialog Box appears at start, 
make a selection to start 
Sysmac Studio.  

 

Power supply 

LAN cable 

LAN cable 

Switching hub 

CPU Unit End cover 

LAN cable 

Controller  

Built-in EtherNet/IP port 
(PORT1) 

Power 
supply 

Personal 
computer 

Communicator 
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4 Sysmac Studio starts up. 
Click New Project.  

 

5 The Project Properties Screen 
appears. Select items 
appropriate for your Controller 
from the pull-down list in each 
field of Select Device.  
Click Create.  
 
The following Controller is used 
in this guide.   

・Category: Controller 
・Device: NX102-1200 
・Version: 1.40 

 
*In this guide, "New Project" is 
used as the project name.  

 

6 The New Project Window 
appears.  
 
The following panes are 
displayed in the window.  
Left: Multiview Explorer 

Upper right: Toolbox 

Lower right: Controller Status Pane 

Upper middle: Edit Pane 

The following tabs are displayed 
in the lower middle of the 
window.  
Output Tab Page  

Build Tab Page 

 

Controller 
Status 
Pane  

Toolbox 

Edit Pane Multiview 
Explorer 

Output Tab 
Page  

Build Tab 
Page 
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7 Double-click Built-in 
EtherNet/IP Port Settings 
under Configurations and 
Setup – Controller Setup in the 
Multiview Explorer.  

 

8 The Built-in EtherNet/IP Port 
Settings Tab Page appears in 
the Edit Pane.  
Check that the TCP/IP settings 
are displayed and that the 
following values are set in the IP 
Address - Port 1. 

・Fixed setting: select 
・IP address: 192.168.250.1 
・Subnet mask: 255.255.255.0 
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7.3.2. Installing the EDS File 
Install the EDS file. 
 

1 Select EtherNet/IP Connection 
Settings from the Tools Menu.  

 

2 The EtherNet/IP Device List Tab 
Page appears in the Edit Pane. 
Right-click Built-in EtherNet/IP 
Port Settings - Port 1 and 
select Edit from the menu 

 

 

3 The Built-in EtherNet/IP Port 
Settings - Port 1 Connection 
Settings Tab Page appears in 
the Edit Pane.   

 

 

4 Right-click on a space (marked 
in red) under Target Device in 
the Toolbox, and select Display 
EDS Library from the menu.  

 

5 The EDS Library Dialog Box 
appears.  
Click Install. 
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6 The Install EDS File Dialog Box 
appears.  
Select 005A000C00540300.eds 
(EDS file) to be installed.  
Click Open.  
 
*For information on how to 
obtain the EDS file, refer to 
Precautions for Correct Use of 
5.2. Device Configuration.   

7 Check that the model name of 
Communicator is added to the 
EDS Library Dialog Box after the 
EDS file is successfully 
installed.  
 
Click Close. 
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7.3.3. Registering the Target Device 
Register the target device.  
 

1 Click the + Button in the 
Toolbox.  

 

2 Data fields of the target device 
registration appear.  
 
Enter 192.168.250.2 in the Node 
address Field. 
 
Select the following model name 
and revision number from 
respective pull-down lists in the 
Model name and Revision 
Fields.   

Model name: Anybus 
Communicator - Slave 

Revision: 3 
 
Check the settings and click 
Add.  

 
 

 

3 The device with IP address 
192.168.250.2 is added to the 
target device list in the Toolbox.   

4 Right-click the target device 
(192.168.250.2) and select Edit 
from the menu.  
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5 The data fields to set the 
parameters appear.  
Enter the following values.  

Output Size: 32 
Input Size: 32 
 

Click OK. 
 
*The device parameters set in 
this dialog box will be added to 
the connection information that 
is set in 7.3.6. Setting 
Connections, and will be 
transferred to Controller in 
7.3.7. Transferring the Project 
Data.  
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7.3.4. Setting Global Variables 
Set global variables to use as tags for tag data links.  
 

1 Double-click Global Variables 
under Programming – Data in 
the Multiview Explorer.  

 

2 The Global Variables Tab Page 
appears in the Edit Pane.  
 
Click on a space under the 
column header Name.  
A new variable can be entered.   
 
 
Enter EIP002_data_OUT in the 
Name Column.   
 
Enter BYTE[32] in the Data 
Type Column.   
After entering, check that the 
data type changes to 
ARRAY[0..31] OF BYTE. 
 
Select Output from the 
pull-down list in the Network 
Publish Column.  

 
 

 
 
 

 
 

 
 

 
 

 

3 Right-click on a space under the 
entered variable, and select 
Create New from the menu.  
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4 In the same way as step 3, enter 
the following data in a new entry 
line.  
・Name: EIP002_data_IN 

Data Type: BYTE[32] 
Network Publish: Input 
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7.3.5. Registering Tags 
Register tags and tag sets.  
 

1 Click the Tag Set Button on the 
Built-in EtherNet/IP Port 
Settings - Port 1 Connection 
Settings Tab Page.  
Click the Input Tab in the Tag 
Sets.  

 

2 Right-click on a space on the 
Input Tab Page, and select 
Create New Tag Set from the 
menu.  

 

3 A new tag set name can be 
entered.  
 
 
Enter EIP002_IN in the Tag Set 
Name Column.  

 

 

 

4 While selecting EIP002_IN, 
right-click on a space and select 
Create New Tag from the menu.  
 
 
 
A new tag name can be entered 
under the tag set "EIP002_IN".  
 
Enter the global variable of IN 
No. 1 as a tag, which is listed in 
6.3. Tag Sets.  
 
*When you enter the first 
character (E) of the variable 
name on the Input Tab Page, a 
list of the previously set 
variable names will appear as 
shown in the figure on the right.   
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5 Click the Output Tab. 
Right-click on a space on the 
Output Tab Page, and select 
Create New Tag Set from the 
menu.  

 

6 A new tag set name can be 
entered. In the same way as 
step 3, enter EIP002_OUT. 

 

7 In the same way as step 4, enter 
the global variable of OUT No. 1 
as a tag, which is listed in 6.3. 
Tag Sets.  

 

8 Check that the number of Tag 
Sets is 2 and that the number of 
Tags shows the total number of 
global variables previously set 
(e.g. 2). 

 

 

  



7．EtherNet/IP Connection Procedure 

 33 

7.3.6. Setting Connections 
Set connections to associate the target variables with the originator variables.  
 

1 Click the Connection Button on 
the Built-in EtherNet/IP Port 
Settings - Port 1 Connection 
Settings Tab Page.   

 

2 Right-click on a space under the 
column header Target Device in 
the Connection and select Add 
from the menu.   

3 A new connection can be 
entered.  
 
 
Select 192.168.250.2 from the 
pull-down list in the Target 
Device Column.   

 
 
 

 

4 The connection "default_001" is 
generated. 
Select Exclusive Owner from 
the pull-down list in the 
Connection I/O Type Column. 

 

5 The target variables and 
originator variables can be set.  
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6 Click on the cell in the Target 
Variable Column for Input.  
 
Press Ctrl + Space on the 
keyboard. Applicable instance 
numbers appear. (100, in this 
guide) 
 
*A list of instance numbers will 
also appear when you enter the 
first character (e.g. 1) of the 
instance number.  

 
Select the instance number 100. 
 
 
Likewise, select the instance 
number 150 from the list in the 
Target Variable Column for 
Output.  

 
 
 

 
 
 

 
 
 

 

7 Click on the cell in the Originator 
Variable Column for Input. 
A pull-down list of the previously 
registered tag set names 
appears.  
Select the tag set name 
EIP002_IN.  

 
 

 

8 Likewise, select the tag set 
name EIP002_OUT in the 
Originator Variable Column for 
Output.  

 

9 Select Point to Point 
connection from the pull-down 
list in the Connection Type 
Column for both Input and 
Output.  

 

10 Change the values in both the 
RPI[ms] and Timeout Value 
Columns.  
 
*In this guide, the default values 
are used.  

 

11 Check that the number of 
Connections is 2.   
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7.3.7. Transferring the Project Data 
Place Sysmac Studio online and transfer the connection settings and project data to the 
Controller.  
 

 
Regardless of the operating mode of the CPU Unit, devices or machines may 
perform unexpected operation when you transfer any of the following data from 
Sysmac Studio: a user program, configuration data, setup data or device 
variables.  
Always ensure safety at the destination node before you transfer the project 
data.  

 

 

1 Turn ON Controller, Switching 
hub and Communicator.  

 

2 Select Check All Programs 
from the Project Menu.  

 

3 The results of the program check 
are displayed on the Build Tab 
Page. Check that the tab page 
shows the results "0 Errors" and 
"0 Warnings".  

 

4 Select Rebuild Controller from 
the Project Menu.  

 

5 The dialog box on the right 
appears. Confirm that there is 
no problem, and click Yes.  

 

6 Check that the Build Tab Page 
shows the results "0 Errors" and 
"0 Warnings". 

 

7 Select Communications Setup 
from the Controller Menu.  
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8 The Communications Setup 
Dialog Box appears.  
Check that the option Direct 
connection via Ethernet is 
selected in the Connection type 
Field.  
 
Click OK. 
 
*The direct connection via 
Ethernet is possible with or 
without a switching hub if you 
make a 1:1 connection 
between Sysmac Studio and 
Controller.  

 

9 Select Online from the 
Controller Menu.  
 
 
 
 
 
*If the dialog box on the right 
appears, check the message 
and click OK. Then select 
Online again.  

 
 
 
*If the dialog box on the right 
appears, check the message 
and click Yes.  

 
*The message of the dialog box 
varies with the status of 
Controller. Check the message 
and click on an appropriate 
button to proceed with the 
processing. 

 
 

 
 

 
 

10 When an online connection is 
established, a yellow line 
appears under the toolbar.  

 

 

 Additional Information 
For information on online connections, refer to Section 6. Online Connections to a Controller 
of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  
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11 Select Synchronize from the 
Controller Menu. 

 

12 The Synchronization Dialog Box 
appears.  
Check that the data to be 
transferred (e.g. NX102) is 
selected.  
Uncheck the box for Do not 
transfer the EtherNet/IP 
connection settings (i.e., tag 
data link settings).  
Click Transfer To Controller. 
 
*After you click on the button, 
the data is transferred from the 
Sysmac Studio to the Controller 
and is synchronized.  

 

 

13 The dialog box on the right 
appears. Confirm that there is 
no problem, and click Yes.  
 
 
A message appears stating 
"Synchronizing". 
 
 
The dialog box on the right 
appears. Confirm that there is 
no problem, and click No. 
 
*Do not return to RUN mode.  
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14 As shown in the figure on the 
right, the font color used to 
display the synchronized data 
changes to white which is the 
color used to specify 
"Synchronized". Check that a 
message appears stating "The 
Synchronization process 
successfully finished". 
Confirm that there is no 
problem, and click Close.  
 
*When the project data created 
in Sysmac Studio matches the 
Controller data, a message 
appears stating "The 
Synchronization process 
successfully finished". 

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  

 

 

15 Check that the ERR/ALM 
indicator in the Controller Status 
Pane changes to a green color 
and that PROGRAM mode is 
displayed.  
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 Precautions for Correct Use 

If you change the connection settings (i.e. tag data link table) after synchronization, you 
cannot transfer the changed connection settings by synchronizing the data again.  
 
To transfer the connection 
settings changed after 
synchronization, display the 
Built-in EtherNet/IP Port 
Settings - Port 1 Connection 
Settings Tab Page and then 
click Transfer to Controller, 
as shown in the figure on the 
right.  
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7.4. EtherNet/IP Communication Status Check 
Confirm that EtherNet/IP tag data links are in normal operation. 
 

7.4.1. Checking the Connection Status 
Check the EtherNet/IP connection status.  
 

1 Check with the LED indicators 
on Controller that the tag data 
links are in normal operation.  
 
The LED indicators in normal 
status are as follows:  

NET RUN: Green lit 
NET ERR: Not lit 
LINK/ACT: Yellow flashing  
(Flashing while packets are 
being transmitted and 
received) 

 
*The NJ-series Controllers also 
have the same LED indicator 
status.  

 
 
 
 

   

2 Check the LED indicators on 
Communicator. 
 
The LED indicators in normal 
status are as follows: 

1 MOD STATUS: Green lit 
2 NET STATUS: Green lit 
3 LINK/ACTIVITY1:  
     Flashing while packets   

are being transmitted 
and received 

 

 

3 Click the EtherNet/IP Device 
List Tab.  

 

4 Right-click Built-in EtherNet/IP 
Port Settings - Port 1 and 
select Monitor from the menu.   

Built-in EtherNet/IP (Port 1) 
Status Indicators 
 

 

2 NET STATUS 1 MOD STATUS 

3 LINK/ACTIVITY1 
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5 The Built-in EtherNet/IP Port 
Settings - Port 1 Connection 
Monitor Tab Page appears. 

 

6 Click the Status Tab.  
The tag data links are in normal 
operation when the same check 
boxes as in the figure on the 
right are selected.  

 

7 Click the Connection Status 
Tab.  
Check that ● appears to the 
left of the applicable connection 
in the Connection Name 
Column.  
Check that 00:0000 is displayed 
in the Status Column.  

 

 

8 Click the Tag Status Tab.  
Check that all the previously set 
tags are displayed in the Tag 
Name Column and that ● 
appears to the left of each tag. 
Check that "Normally resolved" 
is displayed in the Status 
Column for each tag.  

 

  

Number: Node number 
Blue: Connection normal  
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8. Initialization Method 
 
The setting procedures in this guide are based on the factory default settings.  
Some procedures may not be applicable unless you use the devices with the factory default 
settings.  
 

8.1. Initializing a Controller 
To initialize a Controller, clear all memory of a CPU Unit.  
With Sysmac Studio, change the operating mode of Controller to PROGRAM mode and select 
Clear All Memory from the Controller Menu. The Clear All Memory Dialog Box appears. 
Check the message and click OK.  
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9. Revision History 
 

Revision 
code 

Date of 
revision 

Description of revision 

01 January 2021 New entry 
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